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PREFACE 
 
This document assumes that the reader is generally familiar with using computer hardware and 
software. Describing a feature that is usually easily understood has been avoided wherever 
possible.  
 
 
 

Introduction 
 
TrueCrypt is a software system for establishing and maintaining an on-the-fly-encrypted volume 
(data storage device). On-the-fly encryption means that data are automatically encrypted or 
decrypted right before they are loaded or saved, without any user intervention. No data stored on 
an encrypted volume can be read without using the correct password or encryption key. Until 
decrypted, encrypted volume appears to be nothing more than a series of random numbers. Entire 
file system is encrypted (i.e. file names, folder names, contents of every file, and free space). No 
unencrypted data are ever stored on any storage device (they are only temporarily kept in RAM 
during the encryption/decryption process). 
 
 

TrueCrypt Volume 
 
There are two basic types of TrueCrypt volumes:  

• Container 
• Partition/device 

 
A TrueCrypt container is a normal file, which can reside on any type of storage device. It contains 
(hosts) a completely independent encrypted virtual disk device. Container is a file-hosted volume. 
 
A TrueCrypt partition is a hard disk partition encrypted using TrueCrypt. You can also encrypt 
floppy disks, ZIP disks, USB hard disks, USB memory sticks, and other types of storage devices. 
 

Creating a New TrueCrypt Volume 
 
To create a new TrueCrypt file-hosted container or to encrypt a partition/device (requires 
administrator privileges), click on ‘Create Volume’ in the main program window. TrueCrypt Volume 
Creation Wizard should appear. As soon as the Wizard appears, it starts collecting data that will be 
used in generating the master key, the salt, and the values used to create the IV and ‘whitening’ 
values for the new volume. The collected data, which should be as random as possible, include 
your mouse movements, mouse clicks, key presses, and other values obtained from the system 
(for more information, please see Random Number Generator). The Wizard provides help and 
information necessary to successfully create a new TrueCrypt volume. However, several items 
deserve further explanation: 
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Hash Algorithm 

By setting this option you select which hash algorithm TrueCrypt will use. The selected hash 
algorithm is used by the random number generator (which generates the master key, salt, and the 
values used to create IV and ‘whitening’ values). It is also used in deriving the new volume header 
key.  

TrueCrypt currently supports two hash algorithms: RIPEMD-160, which was designed by an open 
academic community, and SHA-1 designed by the NSA and NIST. 

Note that the output of a hash function is never used directly as an encryption key. For more 
information, please see the section Technical Details. 
 

Quick Format 
 
If unchecked, each sector of the new volume will be formatted. Basically this means that the new 
volume will be entirely filled with random data. Quick format is much faster but may be less secure 
because until the whole volume has been filled with files, it may be possible to tell how much data 
it contains (if the space was not filled with random data beforehand). If you are not sure whether to 
enable or disable Quick Format, we recommend that you leave this option unchecked.  
Note that Quick Format can only be enabled when encrypting partitions. 
  

Cluster Size 
 
Cluster is an allocation unit. For example, for a one-byte file, at least one cluster should be 
allocated on FAT file system. When the file grows beyond the cluster boundary, another cluster is 
allocated. Theoretically, this means that the bigger the cluster size, the more disk space is wasted; 
however, the performance is better. If you do not know which value to use, leave the setting at 
default. 
 

Auto-Test All Algorithms 
 
The built-in self-test facility, accessible from the Volume Creation Wizard Step 2 window, 
automatically tests all the encryption algorithms and all the hash algorithms (HMAC’s) implemented 
in TrueCrypt and reports the results. To run these tests, click on the Auto-Test All Algorithms 
button in the test tool window. We recommend that you test the algorithms each time right before 
creating a new TrueCrypt volume. 
 

TrueCrypt Volume on CD, DVD, and Other Read-Only Media 
 
If you want a TrueCrypt volume to be stored on a CD, DVD, or other read-only media, first create a 
file-hosted TrueCrypt container on a hard drive and then burn it onto a CD, DVD, etc., with any CD 
burning software (or, under Windows XP, with the built-in system tool). Remember that if you need 
to mount a TrueCrypt volume that is stored on a read-only medium (such as a CD or DVD) under 
Windows 2000, you must format the volume as FAT (Windows 2000 cannot mount NTFS file 
system on read-only media).  
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Additional Notes on Volume Creation 
 
After you click the 'Format' button in the Volume Creation Wizard window (the last step), there will 
be a short delay while your system is being polled for additional random data. Afterwards, the 
master key, header key, salt, and the values used to create the IV and ‘whitening’ values for the 
new volume will be generated, and the master key and header key contents will be displayed.  
 
 
For increased security, the random pool, master key, and header key contents can be prevented 
from being displayed by unchecking the checkbox in the upper right corner of the corresponding 
field: 
 

 
 
Note that only the first 112 bits of the pool/keys are displayed (not the entire contents). 
 
TrueCrypt volumes can be reformatted as FAT12, FAT16, FAT32, or NTFS anytime. They behave 
as standard disk devices so you can right-click the device icon and select 'Format'.  
 
Warning: When encrypting entire hard drive partition or entire device (floppy disk, ZIP disk etc.), all 
data stored on the device/partition will be lost! 
      
 

Plausible Deniability 
 
 It is impossible to identify a TrueCrypt container or partition. Until decrypted, a TrueCrypt volume 
appears to consist of nothing more than random data (it does not contain any "signature"). 
Therefore, it is impossible to prove that a file, a partition or a device is a TrueCrypt volume and/or 
that it has been encrypted.  
 
TrueCrypt container files do not have to have a standard file extension. They can have any file 
extension you like (for example, .raw, .dat, .iso, .img, .rnd, .tc) or they can have no file extension at 
all. TrueCrypt ignores file extensions. If you need plausible deniability, make sure your TrueCrypt 
volumes do not have the .tc file extension (this file extension is ‘officially’ associated with 
TrueCrypt). 
 
When formatting a hard disk partition as a TrueCrypt volume, the partition table (including the 
partition type) is never modified. If you intend to use a TrueCrypt partition and you need plausible 
deniability, follow these steps (Windows XP): 
 

1) Make sure you have administrator privileges. 
2) Right-click My Computer icon on your desktop and select Manage. 
3) In the list (on the left) click Disk Management (the Storage sub-tree). 
4) If the partition that you want to format as a TrueCrypt has already been created, right-click it 

and select Delete Partition…  If the partition has not yet been created, continue with step 4) 
5) Right-click the free space (should be labeled as Unallocated) and select New Partition… 
6) New Partition Wizard should appear now. Follow its instructions. On the Wizard page called 

‘Assign Drive Letter or Path’ select ‘Do not assign a drive letter or drive path’. Click Next. 
7) Select Do not format this partition and click Next. 
8) Click Finish. 
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9) The partition now appears to be “reserved” for future use (and future reformatting). As it is 
unformatted, it can contain any random data, which might, for example, have resided on the 
hard drive since the last time you repartitioned the hard disk. Therefore, there is no 
difference between such an unformatted partition and a TrueCrypt volume. Now you can 
format the partition as TrueCrypt (to do that, click Create Volume in the main program 
window and follow the Volume Creation Wizard’s instructions). 
 
Note: if, instead of an unformatted partition, you format an NTFS/FAT16/FAT32 partition as 
TrueCrypt, the partition will then appear to be a corrupted NTFS/FAT16/FAT32 partition. 

 
Main Program Window 
 
Select File 
 
Allows you to select a file-hosted TrueCrypt volume. After you select it, you can mount it by clicking 
‘Mount’ (see below). It is also possible to select a volume by dragging its icon to the 
‘TrueCrypt.exe’ icon (TrueCrypt will be automatically launched then). 
 

Select Device 
 
Allows you to select a TrueCrypt partition or a storage device (such as floppy disk or ZIP disk). 
After it is selected, it can be mounted by clicking ‘Mount’ (see below). Note: There is a more 
comfortable way of mounting TrueCrypt partitions – see ‘Auto-Mount Partitions’ for more 
information. 
 

Mount 
 
To mount a TrueCrypt volume, select a free drive letter from the list in the main window. Then 
select a file or device that hosts the TrueCrypt volume and click ‘Mount’. TrueCrypt will try to mount 
the volume using cached passwords (if there are any) and if none of them works, it asks you to 
enter a password. If you enter the correct password, the volume will be mounted. 
 
Note that switching users on Windows XP/2000 does not dismount a successfully mounted 
TrueCrypt volume. Also note that when you exit the TrueCrypt application, the TrueCrypt driver still 
continues working and no TrueCrypt volumes are dismounted. 
 

Auto-Mount Partitions 
 
This function allows you to mount TrueCrypt partitions without having to select them manually (by 
clicking ‘Select Device’). TrueCrypt goes through all available partitions (on all hard drives) one by 
one and tries to mount each of them as a TrueCrypt volume. Note that TrueCrypt partition cannot 
be identified, nor the cipher it has been encrypted with. Therefore, the program cannot directly 
“find” TrueCrypt partitions. Instead, it has to try mounting each (even unencrypted) partition using 
all encryption algorithms and all cached passwords (if there are any). Therefore, be prepared that 
this process may take a long time on slow computers. Drive letters will be assigned starting from 
the one that is selected in the drive list in the main window. If the password you enter is not correct, 
mounting is tried using cached passwords (if there are any). If you enter empty password, only the 
cached passwords will be used when attempting to mount partitions. 
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Dismount 
 
To dismount a TrueCrypt volume basically means to make any access to the data it contains 
impossible. To do so, select a TrueCrypt volume and click on ‘Dismount’.  

 
Dismount All 
 
Dismounts all currently mounted TrueCrypt volumes. 
 

Wipe Cache 
 
Clears any passwords cached in driver memory. When there are no passwords in the cache, this 
button is disabled. Up to last four successfully mounted TrueCrypt volume passwords can be 
cached. This allows mounting volumes without having to type their passwords repeatedly. 
Passwords are never saved on any disk – they are only temporarily stored in RAM. Driver memory 
is never swapped to disk. Password caching can be enabled/disabled in the Preferences (Tools 
menu). 
 

Change Password 
 
Allows changing the password of the currently selected TrueCrypt volume. The main encryption 
key remains unchanged. Therefore, reformatting is not necessary and is not performed (i.e. no 
data will be lost after changing the password and the password change will only take a few 
seconds). To change the password of a TrueCrypt volume, click on ‘Select File’ or ‘Select Device’, 
then select the volume, and click on ‘Change Password’. 
 
PKCS-5 PRF Algorithm: When changing a volume password, you can also select the HMAC hash 
algorithm that will be used in deriving the new volume header key (for more information, see 
Header Key Derivation) and in generating the new salt (for more information, see Random Number 
Generator). 
 

Never Save History 
 
If checked, the file names and paths of the last eight mounted volumes will not be saved in the 
history. 
 

Exit 
 
Terminates the TrueCrypt application. The driver continues working and no TrueCrypt volumes are 
dismounted. 
 
 

Password Entry 

Cache Password in Driver Memory 
 
When checked, the volume password you enter will be cached in driver memory (if the password is 
correct). Then, later, volumes can be mounted using the cached password without having to type it 
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again. Up to four passwords can be cached. The passwords are never saved on any disk. They 
are only temporarily stored in RAM. Driver memory is never swapped to disk. Note that turning the 
password cache off will not clear it (click Wipe Cache to do so). 
 

Program Menu 
 
Note: Only the menu items that are not self-explanatory are described in this documentation. 
 

File -> Exit 
 
Terminates the TrueCrypt application. The driver continues working and no TrueCrypt volumes are 
dismounted. 
 

Tools -> Clear Volume History 
 
Clears the list containing file names and paths of the last eight successfully mounted TrueCrypt 
volumes. 
 

Tools -> Preferences 
 
Wipe cached passwords on exit 
 
If enabled, passwords cached in driver memory will be cleared when exiting TrueCrypt.  
 
 
Cache passwords in driver memory 
 
When checked, up to last four successfully mounted TrueCrypt volume passwords will be cached 
in driver memory. Then, later, volumes can be mounted using a cached password without having 
to type it again. The passwords are never saved on any disk. They are only temporarily stored in 
RAM. Driver memory is never swapped to disk. 
 
 
Open Explorer window for successfully mounted volume 
 
If this option is checked, then after a TrueCrypt volume has been successfully mounted, an 
Explorer window showing the root directory of the volume (e.g. T:\) will be automatically open. 
 
 
Close all Explorer windows of volume being dismounted 
 
Sometimes, dismounting a TrueCrypt volume is not possible due to the fact that some files or 
folders located on the volume are in use or “locked”. This also applies to Explorer windows 
displaying directories located on TrueCrypt volumes. When this option is checked, all such 
windows will be automatically closed before dismounting, so that the user does not have to close 
them manually. 
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Supported Operating Systems 
 
TrueCrypt runs on the following operating systems: 
 

• Windows 2003 
• Windows XP 
• Windows 2000 
 

We recommend Windows XP (at least Service Pack 1) or later as the optimum environment for 
running TrueCrypt. 
 

Uninstalling TrueCrypt 
 
To uninstall TrueCrypt, open the Windows control panel and select ‘Add/Remove Programs’, locate 
TrueCrypt and click the ‘Add/Remove’ button. 
 
Normally, all TrueCrypt files, including the device driver, should be removed, and most of the 
changes made to the registry should be undone. The uninstall will never remove any TrueCrypt 
volume you may have created. 
 

Command Line Usage 
 
/help or /?   Displays command line help. 
/volume or /v  File and path name of a TrueCrypt volume. To mount a hard disk partition, 

use, for example, /v \Device\Harddisk1\Partition3 (to determine 
the path to a partition, run TrueCrypt and click Select Device). 

/letter or /l  Driver letter to mount the volume as. 
/explore or /e  Opens an Explorer window after a volume has been mounted. 
/beep or /b  Beeps after a volume has been mounted. 
/auto or /a  Automatically mounts the volume. 
/dismount or /d Dismounts the given volume (specified by its drive letter) or when no volume 

is specified, dismounts all currently mounted TrueCrypt volumes. 
/cache or /c  Enables (Y) or disables (N) the password cache. Note that turning the 

password cache off will not clear it. 
/history or /h  Enables (Y) or disables (N) the history. 
/wipecache or /w Wipes any passwords cached in the driver memory. 
/password or /p The volume password. If the password contains spaces, it must be enclosed 

in quotation marks (e.g., /p “My Password”). Warning: This method of 
entering a volume password is not secure, particularly when you save the 
password in an unecrypted batch file, or when an unencrypted command 
prompt history log is being saved to disk. Consider using /q /a instead. 

/quiet or /q Quiet mode. When used along with /auto and if no cached password is 
correct, the password prompt appears (the main TrueCrypt window is not 
displayed). This could increase the level of privacy in multi-user 
environments. Program settings are not saved when in quiet mode. 
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Syntax 
 
truecrypt [[/v] volume] [/d [letter]] [/l letter] [/e] [/b] [/p password] 
[/h] [/q] [/c] [/w] [/a] 
 
The order of the parameters is not important. Whitespaces between parameters and parameter 
values do not matter. 
 

Examples 
 
Mounting a volume called 'myvolume.tc' using the password ‘MyPassword’, drive letter X, 
TrueCrypt will open an explorer window and beep, mounting will be automatic: 
 
truecrypt /v myvolume.tc /lx /a /p MyPassword /e /b 
 
Mounting a volume called ' myvolume.tc' using the password prompt (the main program window 
will not be displayed): 
 
truecrypt /v myvolume.tc /lx /a /q 
 
 

Encryption Algorithms 
 
TrueCrypt volumes can be encrypted using one of the following algorithms: 
 

Algorithm Designer(s) 
Key 
Size 
(Bits) 

Block 
Size 
(Bits) 

Mode 

     

AES J. Daemen, V. Rijmen 256 128 CBC 

Blowfish B. Schneier 448 64 CBC 

CAST5 C. Adams, S. Tavares 128 64 CBC 

Triple-DES IBM, NSA 168 64 Outer-CBC 

     
 
A random value, unique to each sector and volume, is used as the IV (for more information, please 
see Sector Scrambling).  
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Troubleshooting 
 
This section presents possible solutions to common problems that you may run into when using 
TrueCrypt. If your problem is not listed here, it might be listed in one of the following sections:  
 
Incompatibilities 
Driver Limitations & Known Bugs 
Frequently Asked Questions 
 
 
 
PROBLEM:  
 
I cannot encrypt a partition because it is not displayed in the ‘Select Device’ window. 
 
PROBABLE CAUSE:  

 
The partition is probably in use by the system or a program.  

 
POSSIBLE SOLUTION: 

 
First close or disable all programs that might be using the partition in any way. If it does not help, 
right-click the My Computer icon on your desktop and select Manage -> Storage -> Disk 
Management. Then right-click the partition that you want to encrypt, and click Change Drive Letter 
and Paths, then click Remove and OK. Restart your system. 
 
 
PROBLEM:  
 
I cannot encrypt a partition because the TrueCrypt Volume Creation Wizard says it is in use. 

 
POSSIBLE SOLUTION: 

 
First make sure that you are not trying to encrypt the operating system boot partition (TrueCrypt 
does not support this). Then close or disable all programs that might be using the partition in any 
way. If it does not help, right-click the My Computer icon on your desktop and select Manage -> 
Storage -> Disk Management. Then right-click the partition that you want to encrypt, and click 
Change Drive Letter and Paths, then click Remove and OK. Restart your system.   
 
 
PROBLEM:  
 
My system crashes when I dismount a TrueCrypt volume. 
 
PROBABLE CAUSE:  

 
This is probably caused by an anti-virus program running in the background. 

 
POSSIBLE SOLUTION: 

 
It usually helps to turn off real-time (on-access) scanning in the preferences of the anti-virus 
program you use. If it does not help, try disabling or uninstalling the anti-virus program completely. 
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PROBLEM:  
 
One of the following problems occurs: 
 
1. A TrueCrypt volume cannot be mounted  
2. NTFS TrueCrypt volumes cannot be created 
 
In addition, the following error may be reported: "The process cannot access the file because it is 
being used by another process."  
 
PROBABLE CAUSE:  

 
This is probably caused by an interfering virus protection software application. 

 
POSSIBLE SOLUTION: 

 
It usually helps to turn off real-time (on-access) scanning in the preferences of the virus protection 
software you use. If it does not help, try temporarily disabling the virus protection software. If this 
does not help either, try uninstalling it completely. 
 
 
 

Incompatibilities 
 
There are a few pieces of software that we know about that might, under certain circumstances, 
cause problems if run with TrueCrypt. 
 
• McAfee Antivirus (Windows 2000 SP4) 
 

If system crashes occur when dismounting a TrueCrypt volume, try disabling the on-access 
scanner in the McAfee Antivirus preferences before mounting a TrueCrypt volume and leave it 
disabled while it is mounted. 
 

• Symantec Norton AntiVirus (Windows 2000 SP4) 
 
There have been contradicting reports. Most users reported that they had no problems running 
Symantec Norton AntiVirus with TrueCrypt (and our tests revealed no problems either). If you 
have Norton AntiVirus installed and system crashes occur when dismounting TrueCrypt 
volumes, try disabling ‘File System Real Time Protection’ in the Norton AntiVirus preferences.  
 

• Nero InCD 
 
Note that even though this incompatibility has been reported by several users, we cannot 
confirm it (repeated tests under Windows XP Professional SP1 and Windows 2000 SP4 yielded 
negative results). However, we believe that the issue might really exist so we have added this 
piece of software to this list. 
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Driver Limitations & Known Bugs  
 
• Network volumes are not supported. A mounted TrueCrypt volume cannot be shared over a 

network (LAN etc.) 
 

• Raw floppy disk volumes: when a floppy disk is ejected and another one is inserted, garbage 
will be read/written to the disk, which could lead to data corruption. This affects only ‘raw’ 
floppy disk volumes (not file-hosted containers stored on floppy disks). 

 
 

TrueCrypt System Files 
 
WindowsPath\TrueCryptSetup.exe (uninstaller) 
 
WindowsPath\SYSTEM32\DRIVERS\truecrypt.sys  (driver) 
 
WindowsPath\SYSTEM32\TrueCryptService.exe  (service) 
 
The service is necessary to register each newly mounted volume with the operating system (Mount 
Manager), which then assigns a drive letter to it. The service also allows users without 
administrator privileges to dismount TrueCrypt volumes.  
 
 
Note: Replace WindowsPath with your Windows installation path (e.g. C:\WINDOWS) 
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Frequently Asked Questions 
 
 
Q: I forgot the password – is there any way to recover the files from my TrueCrypt volume? 
 
A: TrueCrypt does not contain any mechanism or facility that would allow partial or complete 
recovery of your encrypted data without knowing the correct password or the key used to encrypt 
the data. The only way to recover your files is to try to ‘crack’ the password or the key, but it could 
take thousands or millions of years depending on the length and quality of the password, or on the 
key size, on the software/hardware efficiency, and on other factors.  
 
 
Q: Is my password stored somewhere? 
 
A: No.  
 
 
Q: Is some hash of my password stored somewhere? 
 
A: No.  
 
 
Q: Is the key size limited to 160 bits when I use HMAC-SHA-1 or HMAC-RIPEMD-160? 
 
A: No, TrueCrypt never uses an output of a hash function directly as an encryption key. See the 
section ‘Header Key Derivation’ for more information. 
 
 
Q: What is the maximum possible size of a TrueCrypt volume? 
 
A: TrueCrypt volumes can be up to 9,223,372,036 GB. However, you need to take into account the 
following: the limitations of the file system that the container will be stored on, the limitations of the 
file system of the container itself, the hardware connection standard, and your operating system 
limitations. Remember that file-hosted containers stored on the FAT32 file system cannot be larger 
than 4 GB (if you need a larger volume, store it on the NTFS file system or, instead of creating a 
file-hosted volume, encrypt a partition). Also note that any FAT32 volume, encrypted or not, cannot 
be larger than 2048 GB (if you need larger volumes, format them as NTFS). 
 
 
Q: Which cipher is the most secure? 
 
A: Unfortunately, it is impossible to answer this question. However, all ciphers implemented in 
TrueCrypt are well known and trusted. No weak cipher has been implemented in TrueCrypt. 
  
 
Q: How does TrueCrypt verify that the correct password was entered? 
 
See section Technical Details – Encryption Scheme. 
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Q: Is it possible to mount a TrueCrypt container that is stored on a CD or DVD? 
 
A: Yes, it is. However, if you need to mount a TrueCrypt volume that is stored on a read-only 
medium (such as a CD or DVD) under Windows 2000, the file system of the TrueCrypt volume 
must be FAT (Windows 2000 cannot mount NTFS file system on read-only media).  
 
 
Q: What will happen if I format a TrueCrypt partition? 
 
See the question “Is it possible to change the file system of an encrypted volume?” 
 
 
Q: Is it possible to change the file system of an encrypted volume? 
 
A: Yes, when mounted, TrueCrypt volumes can be formatted as FAT12, FAT16, FAT32, or NTFS. 
The volumes behave as standard disk devices so you can right-click the device icon (for example 
in ‘My Computer’ list) and select 'Format'. The actual volume contents will be lost, the whole 
volume will remain encrypted though. If you format a TrueCrypt-encrypted partition when the 
TrueCrypt volume that the partition hosts is not mounted, then the volume will be destroyed, and 
the partition will not be encrypted anymore (it will be empty). 
  
 
Q: How do I decrypt a TrueCrypt partition permanently? 
 
A: If you format a TrueCrypt-encrypted partition when the TrueCrypt volume hosted by the partition 
is not mounted, then the volume will be destroyed and the partition will not be encrypted anymore 
(it will be empty). Note that the contents of the TrueCrypt volume will be lost. 
 
 
Q: How do I burn a TrueCrypt container larger than 2 GB onto a DVD? 
  
A: The DVD burning software you use should allow you to select the format of the DVD. If it does, 
select the UDF format (ISO format does not support files over 2 GB). 
 
 
Q: Can I use tools like chkdsk, Defrag, etc. on the contents of a TrueCrypt volume?  
 
A: Yes, TrueCrypt volumes behave like real physical disk devices, so it is possible to use any 
filesystem checking/repairing/defragmenting tools on the contents of a mounted TrueCrypt volume. 
 
 
Q: Is it possible to encrypt my operating system boot partition? 
 
A: No, TrueCrypt does not allow this. However, there are ways to ensure that the volume where 
operating system resides is read-only, which should prevent information leakage (registry, 
temporary files, etc., are stored in RAM). For more information, see the question “Does TrueCrypt 
support something like ‘traveller’ mode?” 
 
 
Q: Can I mount a TrueCrypt volume stored on another TrueCrypt volume?  
 
A: Yes, TrueCrypt volumes can be nested without any limitation. 
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Q: Can I run TrueCrypt with another on-the-fly disk encryption tool on one system? 
 
A: We are not aware of any on-the-fly encryption tool that would cause problems when run with 
TrueCrypt, or vice versa. 
 
 
Q: Can I resize a TrueCrypt partition?  
 
A: Unfortunately, TrueCrypt does not support this. Resizing a TrueCrypt partition using a program 
such as PartitionMagic will, in most cases, corrupt its contents. 
 
 
Q: Will I always be able to mount a TrueCrypt container no matter how fragmented it is? 
 
A: Yes. 
 
 
Q: Is it necessary to restart the computer before copying a TrueCrypt container? 
 
A: No, it is not necessary.  
 
 
Q: Is it secure to create a new container by cloning an existing container? 
 
A: You should always use the Volume Creation Wizard to create a new TrueCrypt volume. If you 
copy a container and then start using both this container and its clone in a way that both eventually 
contain different data, then you could aid cryptanalysis. The reason is that both volumes would 
share the same key, IVs, whitening values, etc. 
 
 
Q: Do I have to “wipe” free space and/or files on a TrueCrypt volume? 
 
[“Wiping” – secure deletion; overwriting sensitive data to render them unrecoverable.]  
 
A: If you believe that an adversary will be able to decrypt the volume (for example that he will make 
you reveal the password), then the answer is yes. Otherwise, it is not necessary, because the 
volume is entirely encrypted.  
 
 
Q: Does TrueCrypt support something like ‘traveller’ mode? 
 
A: If you need to use TrueCrypt on a computer on which you cannot (or do not want to) install 
TrueCrypt, we recommend using BartPE for this purpose. BartPE stands for “Bart's Preinstalled 
Environment”, which is essentially the Windows operating system prepared in a way that it can be 
entirely stored on and booted from a CD/DVD. The freeware Bart's PE Builder can transform any 
Windows installation CD into BartPE. In order to include certain applications on a BartPE disk (to 
make it available to the BartPE system), you need a plug-in for the application. There are several 
free TrueCrypt plug-ins for BartPE available on the Internet. 
 
 
 
 

http://www.nu2.nu/pebuilder/
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Q: How is TrueCrypt related to E4M? 
 
A: TrueCrypt 1.0 was derived from E4M 2.02a. For information on differences between E4M and 
TrueCrypt, please see Version History. 
 
 
Q: Will TrueCrypt be open-source and free forever? 
 
A: Yes, it will. No commercial version is planned and never will be. We believe in open-source and 
free security software.  
 
Remark: We know that there are certain individuals trying to distribute TrueCrypt as paid and 
closed-source software. We are not affiliated with these individuals. 
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Technical Details 
Encryption Scheme 
 
When mounting a TrueCrypt volume (assume there are no cached passwords), the following steps 
are performed: 
 

1. The first 512 bytes of the volume are read into RAM, out of which the first 64 bytes are the 
salt. 
 

2. A password entered by the user and the salt read in (1) are passed to the header key 
derivation function. A HMAC hash algorithm is chosen and the header key derivation 
function produces a sequence of values (see section Header Key Derivation) from which 
the header encryption key and IV (used to decrypt the volume header) are derived. Note 
that it is impossible to directly determine the correct HMAC hash algorithm that has to be 
used in deriving the correct header key (it has to be determined through the process of trial 
and error). 
 

3. An encryption algorithm is chosen and initialized with the key and IV obtained in (2). Note 
that it is impossible to directly determine the encryption algorithm that has been used to 
encrypt the volume (it has to be determined through the process of trial and error). 
 

4. The data read in (1), except the first 64 bytes, are decrypted with the chosen encryption 
algorithm. Note that now it is still unknown whether the chosen encryption and hash 
algorithms are correct or not. 
 

5. If the first 4 bytes of the data decrypted in (4) contain the text string “TRUE”, then a CRC-32 
checksum of the last 256 bytes of the data read in (1) is calculated. If this value matches 
the value stored at the 8th byte (see section TrueCrypt Volume Format Specification) of the 
data decrypted in (4), the process continues with (6). If the values do not match, or the first 
4 bytes of the data decrypted in (4) do not contain the text string “TRUE”, then the 
encryption algorithm is assumed to be incorrect. If there is an encryption algorithm that 
decrypting has not yet been attempted with, the process continues from (3) choosing such 
encryption algorithm. If there are no encryption algorithms remaining and if there is a 
HMAC hash algorithm that header key derivation has not yet been attempted with, the 
process continues from (2) choosing such HMAC hash algorithm. If there are no HMAC 
hash algorithms and no encryption algorithms remaining to be tested, the password is 
assumed to be incorrect, and mounting is terminated. 
 

6. Now we know that we have the correct password and the correct encryption and hash 
algorithms. The minimum program version required to open the volume, stored in data 
decrypted in (4), is checked. If it is not equal or less than the version of the program that we 
are using to mount the volume, mounting is terminated. 
 

7. The encryption routine is reinitialized with the master key and IV retrieved from the data 
decrypted in (4). This key can be used to decrypt any sector of the volume, except the first 
one (the volume header, which has been encrypted using the header key).  
Note: The master key was generated during the volume creation and cannot be changed 
later. Volume password change is accomplished by re-encrypting the volume header using 
a new header key (derived from a new password). 
 

8. The volume is mounted. 
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For more information pertaining the encryption scheme, see sections Sector Scrambling and 
Header Key Derivation. 
 

TrueCrypt Volume Format Specification 
 
TrueCrypt volume has no “signature”. Until decrypted, it appears to consist of nothing more than 
random data. Therefore, it is impossible to identify a TrueCrypt container or partition. 
 
TrueCrypt volume format version 1 specification: 
 
 
Offset  
(bytes) 

 
  Size 
(bytes) 

 
Encryption 

Status 

 
 

Description 
 

 
      0 
    64 
    68 
    70 
    72 
    76 
    84 
    92 
  100 
  256 
  288 
  512 

 
64 
4 
2 
2 
4 
8 
8 

  8 
156 
32 

224 
  N/A 

 
  Not Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 

 
Salt * 
ASCII string “TRUE” 
Volume format version 
Minimum program version required to open the volume 
CRC-32 checksum of the (decrypted) bytes 256-511 
Volume creation time 
Header creation/modification time 
Reserved (set to zero) 
Unused 
Data used to generate IV and ‘whitening’ values 
Master encryption key 
Data area (actual volume contents) 

 
 
*) Note that salt does not need to be encrypted, as it does not have to be kept secret (salt is a sequence of random values). 
 
 
 
The bytes 0-63 (salt), bytes 256-287 (data used to generate IV and ‘whitening’ values), and bytes 
288-511 (master encryption key), contain random values that have been generated using the built-
in random number generator (see section Random Number Generator) during the volume creation 
process.  
 

Header Key Derivation 
 
Header key is used to decrypt the encrypted area of the TrueCrypt volume header (see sections 
Encryption Scheme and TrueCrypt Volume Format Specification). The technique that TrueCrypt 
uses to generate header keys conforms to PKCS #5 v2.0 (see 
ftp://ftp.rsasecurity.com/pub/pkcs/pkcs-5v2/pkcs5v2-0.pdf). A 64-byte (512-bit) salt is used, which 
means there are 2 to the power of 512 keys for each password. This significantly decreases 
vulnerability to 'off-line' dictionary attacks (pre-computing all the keys for a dictionary of passwords 
is very difficult when a salt is used). 2,000 iterations of the key derivation function have to be 
performed to derive a header key, which significantly increases the time necessary to perform an 
exhaustive search for passwords (brute force). The header key derivation function is based on 
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HMAC-SHA-1 or HMAC-RIPEMD-160 (the user selects which). For more information, please see 
RFC 2104, available at: http://www.cis.ohio-state.edu/htbin/rfc/rfc2104.html). 
 

Sector Scrambling 
 
Each cipher implemented in TrueCrypt operates in CBC mode (Triple-DES in outer-CBC). The IV 
(initialization vector) is a random value, which is unique to each sector and volume. This value is 
generated as follows: 
 

1. Bytes 256-263 (or 256-271 for AES) of the decrypted volume header are retrieved (see 
sections TrueCrypt Volume Format Specification and Encryption Scheme). 
 

2. Data retrieved in (1) are XORed with the 64-bit sector number (each sector is 512 bytes 
long; sectors are numbered starting at 0). In case of AES, the upper and lower 64-bit words 
are XORed with an identical value. The resultant 64-bit value (or 128-bit for AES) is the IV 
for each 64-bit block of the disk sector (128-bit for AES). 
 

Note: Step (1) is only performed once, right after the volume is mounted. The retrieved value 
remains in RAM then. 
 

 
To make obtaining a plaintext/ciphertext pair more difficult, every 8 bytes of each sector (after the 
sector is encrypted) are XORed with a 64-bit value, which is unique to each sector and volume. 
The value is generated as follows: 
 

1. Bytes 264-271 (or 272-279 for AES) of the decrypted volume header are retrieved (see 
sections TrueCrypt Volume Format Specification and Encryption Scheme). 
 

2. Bytes 272-279 (or 280-287 for AES) of the decrypted volume header are retrieved. 
 

3. Data retrieved in (1) are XORed with the 64-bit sector number (each sector is 512 bytes 
long; sectors are numbered starting at 0). 
 

4. Data retrieved in (2) are XORed with the 64-bit sector number. 
 

5. A 32-bit CRC-32 value of the first 8 bytes of the resultant value in (3) is calculated. 
 

6. A 32-bit CRC-32 value of the second 8 bytes of the resultant value in (3) is calculated. 
 

7. A 32-bit CRC-32 value of the first 8 bytes of the resultant value in (4) is calculated. 
 

8. A 32-bit CRC-32 value of the second 8 bytes of the resultant value in (4) is calculated. 
 

9. The value calculated in (5) is XORed with the value calculated in (8). 
 

10. The value calculated in (6) is XORed with the value calculated in (7). 
 

11. The 32-bit value calculated in (9) is written to the upper 32-bit word and the value 
calculated in (10) is written to the lower 32-bit word of the 64-bit ‘whitening’ value. 

http://www.cis.ohio-state.edu/htbin/rfc/rfc2104.html
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Random Number Generator 
 
The random number generator implemented in TrueCrypt is used to generate the master 
encryption key, salt, and the values used to create IV and ‘whitening’ values (see section Sector 
Scrambling).  
 
The random number generator creates a pool of random values in RAM. The pool, which is 256 
bytes long, is periodically filled byte by byte with values derived from the following sources:  
 

• Mouse movements (CRC32-hashed coordinates and event delta times) 
• Mouse clicks (CRC32-hashed event delta times) 
• Key presses (CRC32-hashed key codes and event delta times) 
• Network interface statistics (NETAPI32) (collected only once in the beginning) 
• Performance statistics of disk devices (collected only once in the beginning) 
• Various Win32 handles, time variables, and counters (collected at 250-ms interval) 

 
Random values are written to the pool by adding (not by replacing the old values in the pool). This 
means that from the moment that a value is written to the pool, it never stops affecting the state of 
it. Additionally, after a value (byte) is added to the pool, the pool is entirely hashed using a hash 
function (SHA-1 or RIPEMD-160 – the user selects which). 
 
The described random number generation technique is based on the following: 
 

• Software Generation of Practically Strong Random Numbers by Peter Gutmann,  
(http://www.cs.auckland.ac.nz/~pgut001/pubs/random.pdf) 

 
• Cryptographic Random Numbers by Carl Ellison, 

(http://www.clark.net/pub/cme/P1363/ranno.html) 
 
 

Compliance with Standards and Specifications 
 
TrueCrypt complies with the following standards and specifications: 
 

• PKCS #5 v2.0 (ftp://ftp.rsasecurity.com/pub/pkcs/pkcs-5v2/pkcs5v2-0.pdf) 
 
• FIPS 180-2 – SHA-1 (http://csrc.nist.gov/publications/fips/fips180-2/FIPS180-

2_changenotice.pdf) 
 
• RFC 2104 – HMAC (http://www.cis.ohio-state.edu/htbin/rfc/rfc2104.html) 

 
• RFC 2202 – HMAC-SHA-1 (http://www.cis.ohio-state.edu/htbin/rfc/rfc2202.html) 

 
• FIPS 46-3 – Triple-DES (http://csrc.nist.gov/publications/fips/fips46-3/fips46-3.pdf) 

 
• FIPS 197 – AES  (http://csrc.nist.gov/publications/fips/fips197/fips-197.pdf) 

 
 

http://www.cs.auckland.ac.nz/~pgut001/pubs/random.pdf
http://www.clark.net/pub/cme/P1363/ranno.html
http://csrc.nist.gov/publications.html
http://csrc.nist.gov/publications.html
http://www.cis.ohio-state.edu/htbin/rfc/rfc2104.html
http://www.cis.ohio-state.edu/htbin/rfc/rfc2202.html
http://csrc.nist.gov/publications/fips/fips46-3/fips46-3.pdf
http://csrc.nist.gov/publications/fips/fips197/fips-197.pdf
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Future Development 
 
The following features are planned for a future release: 
 
• ‘Hidden’ volume 

 
• Twofish 

 
• Serpent 

 
• Linux version 

 
• Hash algorithms conceptually distinct from SHA-1 and RIPEMD-160 

 
• Header key derivation PRF algorithms conceptually distinct from HMAC-SHA-1 and  

HMAC-RIPEMD-160 
 

• Keyfiles 
 

• Anti-key-logger facilities 
 
• Hotkeys 
 
and more. 
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Version History 
 
2.1a 
 
October 1, 2004  

Removed Features: 

• IDEA encryption algorithm removed. This allows non-profit and profit organizations to use TrueCrypt 
without having to obtain a separate license for IDEA (according to the IDEA license, any use of 
software containing the IDEA algorithm by a non-profit or profit organization is considered as use for 
commercial purposes, and is subject to a license from MediaCrypt AG). 
 
Important: TrueCrypt volumes encrypted using the IDEA encryption algorithm cannot be mounted 
using TrueCrypt 2.1a. If you have such a volume, before upgrading to TrueCrypt 2.1a, please create a 
new TrueCrypt volume using a cipher other than IDEA and move your files to this new volume.  
 

2.1 
 
June 21, 2004  

New features: 

• RIPEMD-160 hash algorithm added.  The user can now select which hash algorithm TrueCrypt will use 
(SHA-1 or RIPEMD-160).  
 
Note: RIPEMD-160, which was designed by an open academic community, represents a valuable 
alternative to SHA-1 designed by the NSA and NIST. In the previous versions there was a risk that the 
whole program would be practically useless, should a major weakness be found in SHA-1. The user-
selected hash algorithm is used by the random number generator when creating new volumes, and by 
the header key derivation function (HMAC based on a hash function, as specified in PKCS #5 v2.0). The 
random number generator generates the master encryption key, salt, and the values used to create IV 
and ‘whitening’ values. 

• When changing a volume password, the user can now select the HMAC hash algorithm that will be used 
in deriving the new volume header key.  

• It is now possible to create NTFS TrueCrypt volumes and unformatted TrueCrypt volumes. This 
enhancement also removes the 2048 GB volume size limit. (Only FAT volumes can be created using the 
previous versions of TrueCrypt. Any FAT volume, encrypted or not, cannot be over 2,048 GB.) 

• Header key content is now displayed in the Volume Creation Wizard window (instead of salt). 

• Random pool, master key, and header key contents can be prevented from being displayed in the 
Volume Creation Wizard window. 
 

Bug fixes: 

• When there is a mounted TrueCrypt container that is stored in another TrueCrypt container, it will be 
possible to dismount both of them using the ‘Dismount All’ function, and ‘blue screen’ errors will not 
occur upon system shutdown. 

• Minor bug fixes to command line handling. 
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Improvements: 

• Several minor improvements to the driver. 
 

Miscellaneous: 

• Released under the original E4M license to avoid potential problems relating to the GPL license (added 
the IDEA patent information and specific legal notices). 

 
 
2.0 
 
June 7, 2004  

Bug fixes: 

• Data corruption will no longer occur when a TrueCrypt partition is subjected to heavy parallel usage 
(usually when copying files to or from a TrueCrypt partition). This also fixes the problem with 
temporarily inaccessible files stored in TrueCrypt partitions. 

Note: File-hosted volumes were not affected by this bug. 

• After dismounting and remounting a volume, its file system will be correctly recognized by the 
operating system and it will be possible to reuse the same drive letter (Windows 2000 issue). 

• The main program window will not be displayed when run in quiet mode (command line usage).  

• Two password entry attempts are no longer necessary to be able to mount a volume (command line 
usage).  

• All partitions will be visible to TrueCrypt even if one of them is inaccessible to the operating system (an 
inaccessible partition made all successive partitions on the hard disk unavailable to TrueCrypt).  

• Relative path can be specified when mounting a file-hosted volume (command line usage). 

• Incorrect passwords are reported when auto-mounting (command line usage). 
 

New features: 

• AES-256 (Rijndael) encryption algorithm. 

• The command line option /dismountall was renamed to /dismount which can now be also used to 
dismount a single volume by specifying its drive letter. 
 

Improvements: 

• Memory pages containing sensitive data are now locked to prevent them from being swapped to the 
Windows page file. 

• The state of the random pool will never be exported directly so the pool contents will not be leaked. 
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Miscellaneous: 

• Released under GNU General Public License (GPL) 

 
 
1.0a (by TrueCrypt Team) 
 
February 3, 2004  

Removed features: 

• TrueCrypt no longer supports Windows 98/ME. 

 
 
1.0 (by TrueCrypt Team) 
 
February 2, 2004  

Note: TrueCrypt is based on E4M (Encryption for the Masses). Therefore, the following list contains 
differences between E4M 2.02a and TrueCrypt 1.0 (minor differences have been omitted). 
 

Improvements: 

• Windows XP/2000 support 

• The maximum volume size is 18,446,744,073 GB (E4M only allows 2 GB).  
Note: File system, hardware connection standard, and operating system limitations have to be taken 
into account when determining maximum volume size. 

• Plausible deniability. It is impossible to identify a TrueCrypt container or partition. Until decrypted, a 
TrueCrypt volume appears to consist of nothing more than random data (it does not contain any 
"signature"). Therefore, it is impossible to prove that a file, a partition or a device is a TrueCrypt 
volume and/or that it has been encrypted. To achieve plausible deniability, the format of the volume 
and the encryption process had to be significantly changed. 

• The salt is 64 bytes long now (E4M uses 20 bytes). 

• The iteration count of the key derivation function increased to 2,000 (E4M uses 1,000). 

• Free space is filled with random data during volume creation, instead of filling it with zeroes. This 
reduces the amount of predictable plaintext and, in future, will increase the level of plausible deniability 
of hidden volumes. 

• Up to 32 partitions per physical disk drive can be encrypted now (Windows XP/2000). 

• The minimum volume password length has been increased to 12 characters. 

• The maximum volume password length has been decreased from 100 to 64 characters. This was 
necessary to avoid the following: When a password longer than 64 characters was passed to HMAC-
SHA-1, the whole password was first hashed using SHA-1 and the resultant 160-bit value was then 
used instead of the original password (which complies with HMAC-SHA-1 specification), thus the 
password length was in fact reduced. 

• The Blowfish key length size has been increased to 448 bits. 
Remark: Even though our increasing the key size to 448 bits might appear to be a significant overkill, 
there was no reason for us not to do so (note that there is no decrease in speed of 
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encryption/decryption). 
 

Bug fixes: 

• Sector scrambling algorithm flaw fixed. Two or more disk sectors to be encrypted consisting of the 
same values (e.g. filled with zeroes), after being encrypted by E4M, start with the same 8-byte 
sequence of values (i.e. the first eight bytes of any of these encrypted sectors contain the same values 
as the first eight bytes of any other of these encrypted sectors). If this had not been fixed, the 
plausible deniability would not have been possible.  

• TrueCrypt volumes can be dismounted (Windows XP issue). 

• "Blue screen" errors no longer occur during Windows shutdown when there is one or more mounted 
TrueCrypt volumes. 

• Drive geometry is calculated correctly now (chkdsk.exe and format.exe do not fail anymore). 

• A TrueCrypt volume can be reformatted as FAT32 or NTFS using the Windows built-in format tool 
(Windows XP/2000 issue). 

• Windows Check Disk can now be used on TrueCrypt volumes (Windows XP/2000 issue). 

• Windows Disk Defragmenter can now be used on encrypted volumes (Windows XP/2000 issue). 
 

New features: 

• New IV (initialization vector) generation algorithm (see the documentation for more information) 

• Every 8 bytes of each sector (after the sector is encrypted) are XORed with a random 64-bit value, 
which is unique to each sector and volume (sector is 512 bytes long). This makes obtaining a 
plaintext/ciphertext pair a bit more difficult. 

• New function to clear the volume history. 

• When selecting a partition/device, the sizes and file system types of available partitions/devices are 
displayed (Windows XP/2000). 

• List of mounted TrueCrypt volumes now contains their sizes and encryption algorithms used (Windows 
XP/2000). 

• Free volume space is reported (in 'My Computer' list etc.) 

• Windows XP format facilities do not support formatting volumes larger than 32 GB as FAT32. However, 
with TrueCrypt Volume Creation Wizard it is now possible to create FAT32 volumes larger than 32 GB. 

• New function that allows multiple TrueCrypt partitions to be mounted provided that their correct 
password(s) has/have been entered (this includes the cached passwords, if there are any). 

• Quick format (partitions/devices only) 

• Cluster size selection (when creating new volumes) 

• Volume properties can now be examined (encryption algorithm, volume creation time, last password 
change time etc.) 

• New function to dismount all mounted TrueCrypt volumes. 
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• New command line options to dismount all mounted TrueCrypt volumes: /d and /dismountall 

• HMAC-SHA1 and CRC-32 algorithm tests are now included in the self-test facility. 

• Program menu and Preferences window added. 

• Custom user interface fonts supported. 

• Optionally, the TrueCrypt installer can now create System Restore points (Windows XP/ME). 

• Password input field is wiped after a correct volume password has been entered. 

• New graphics, icons, user interface 

• New documentation 
 

Removed features: 

• E4M and SFS volumes are no longer supported. 

• DES cipher removed. 

• HMAC-MD5 removed (to be replaced by HMAC-RIPEMD-160). 
 


	Introduction
	TrueCrypt Volume
	Creating a New TrueCrypt Volume
	Hash Algorithm
	Quick Format
	Cluster Size
	Auto-Test All Algorithms
	TrueCrypt Volume on CD, DVD, and Other Read-Only Media
	Additional Notes on Volume Creation



	Plausible Deniability
	Main Program Window
	Select File
	Select Device
	Mount
	Auto-Mount Partitions
	Dismount
	Dismount All
	Wipe Cache
	Change Password
	Never Save History
	Exit


	Password Entry
	Cache Password in Driver Memory


	Program Menu
	File -> Exit
	Tools -> Clear Volume History
	Tools -> Preferences


	Supported Operating Systems
	Uninstalling TrueCrypt
	Command Line Usage
	Syntax
	Examples


	Encryption Algorithms
	Troubleshooting
	Incompatibilities
	Driver Limitations & Known Bugs
	TrueCrypt System Files
	Frequently Asked Questions
	Technical Details
	Encryption Scheme
	TrueCrypt Volume Format Specification
	Header Key Derivation
	Sector Scrambling
	Random Number Generator
	Compliance with Standards and Specifications

	Future Development
	Acknowledgements
	Version History

